CHAPTER - IV

DESCRIPTION OF TOOLS
CHAPTER-IV
DESCRIPTION OF TOOLS

Tools of educational research are the basic documents employed by the researcher to elicit facts or data in order to substantiate the hypotheses. In the preceding chapters, the introduction to different variables under study, the review of the related literature, objectives and hypotheses have been discussed. The present chapter deals with the description of the tools. For the present investigation, the following tools were used:

Standardized Tests

- Socio Economic Status Scale (A.K. Kalia and Sudhir Sahu)
- Cattell’s Culture Fair Intelligence test (R.B. Cattell and A.K.S Cattell)

Self Developed Tools

- Achievement Test (Developed by the investigator)
- Attitude Scale on environmental science (Developed by the investigator)
- Opinionnaire for teachers (Developed by the investigator)
- Multimedia Package on Environmental Science (Developed by the investigator)

4.1 SOCIO-ECONOMIC STATUS SCALE

Description of Socio-Economic Status Scale developed by A.K. Kalia and Sudhir Sahu (2012)

This scale of socio-economic status is designed to measure social position of a person in urban and rural areas with 40 items in all. It is a verbal scale. This scale has been developed both in English and Hindi languages for urban/rural household. It is easy to be administered and acknowledge the social position of an individual in the society. Scoring process of S.E.S. scale is easy and objective. To get the total S.E.S. scores, the researcher is required
to count the S.E.S. Scores of the answers options mentioned in the square box, which has been ticked (V) by the respondent. In this way it saves time, money and labour.

**Scoring of Socio-Economic Scale**

The scoring of S.E.S. scale is easy and objective. To find out the total score in S.E.S., the examiner should add the scores where the respondent has put a check (V) as his/her response. A separate scoring key has been developed to facilitate the scoring of SESS.

Total scores for SESS are obtained after adding scores from information given by the respondent to part A and responses given to all the items (1-40) of part-B of the test booklet.

**Administration of Socio-Economic Status Scale**

This scale comprised of 40 items of five different areas/dimensions of socio-economic status viz. (i) socio-cultural component (ii) economic component (iii) possession of goods and services (iv) Health component (v) Educational Component. There is no limit for filling this scale. But it takes approximately 20-25 minutes for completing it. While administering S.E.S. scale following precautions should be kept in mind:

1. A proper seating arrangement should be made for the respondents in a peaceful environment.
2. A minimum facility of writing material should be arranged for respondents.
3 All instructions mentioned in the test booklet should be loudly read out by the test administrator.
4. Respondents should be instructed to give their responses only on consumable test booklet.
5. Test administrator should motivate the respondents for free and frank responses by establishing proper rapport with them.
6. All doubts should be clarified before the start of the test.
7. Before collecting the response sheet, the test administrator should and sure that all the test items have been answered by the respondents.

**Reliability of S.E.S. Scale**

Reliability of the scale has been measured by split-half and test-retest method Results given below indicate that the scale is highly reliable.

**Table 4.1**

**Split-Half and Test-Retest Reliability of Socio-Economic Status Scale**

<table>
<thead>
<tr>
<th>English Version</th>
<th>Hindi Version</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Split-Half Method</strong></td>
<td><strong>Test-Retest</strong></td>
</tr>
<tr>
<td>.68</td>
<td>.86</td>
</tr>
</tbody>
</table>

**Validity- of S.E.S. Scale**

All the 40 items of SESS have been evaluated by the various experts. The investigator has established content validity while preparing the preliminary draft of SESS. Expert opinion of teacher educators and language specialists with regard to relevance of each items was ought. For this, a copy of final draft of SESS was given to nine experts who have been directly or indirectly involved in research. The expert opinion came out to be favourable in terms of the relevance of each item in the scale. The criterion validity was measured by correlating it with SESS by Rajbir Singh, Radhey Shyam and S.Kumar (2006) and it came out to be 0.85 which is highly significant.

All 42 items (including caste and academic stream) were analyzed to measure internal consistency of the SESS through Pearson’s product moment, Kendall’s tub correlation and spearman’s rho correlation method. Coefficient of correlation is highly significant in not of the dimensions except only in one dimension i.e. health component due to presence of some items with negative scores. A copy of the SES Test is given in **Appendix-C**.
4.2 Cattell's Culture Fair Intelligence Test

For measuring the intelligence of the students of the sample Cattell's Culture Fair Test of mental abilities was used by the researcher. This test measures individual intelligence in a manner designed to minimize, as much as possible, the influence of verbal fluency, cultural climate and educational level of the students. The testee has to perceive relationship in shapes and figures while attempting the test items.

There are three scales in the Culture Fair Series. For the purpose of the present investigation, Scale - 2, Form A was used which consists of four subtests. The first subtest contains items, which are incomplete and progressive series. He has to select from among the choices provided, the answer which best continues the series. Second subtest is related to classification. The examinee is presented with five figures. He must select one which is different from the other four. The third subtest relates to matrices, the testee is asked to correctly complete the design or matrix presented at the left of each row. In the fourth subtest there are condition figure on the left hand side and the testee is required to select from the five choices provided, the one which duplicates the condition is the most appropriate and suitable.

Before each subtest, examples are illustrated so that the task requirements are clear to the testee before the start of the sub-test.

The Spearman Brown formula and K- R formula 21 reliability coefficients for the scale 2, Form -A are 0.79 and 0.81 respectively. The concept validity of the test is 0.85.

For administering the test, test booklets and answer-sheets were distributed to the students. Then all the necessary instructions were given to the students for filling up the relevant columns. The scoring key is available for scoring the test. The number of correct responses of each answer sheet gave the total score. These raw scores were then converted into normalized I.Q. scores using Table - 2 provided in the manual for scales 2 & 3. A copy of the Cattell's Culture Fair Test is given in Appendix-D.
4.3 ACHIEVEMENT TEST

Achievement tests commonly used today to assess the attainment of major long term educational goals. Here we find tests focusing on the understanding and application of scientific principles, basic cognitive skills that affect the individuals' performance in a wide variety of activities. It also refers to the assessment of the outcomes of formal instruction in cognitive domain (Dwyer, 1982). This test may mean a sample of behavior that provides opportunity for comparison with performance standard, as in criterion referenced testing it aids both the teacher and the students in assessing learning readiness, monitoring learning outcomes.

The researcher made a thorough survey of Achievement Test in the current available material for elementary class students but could not locate an appropriate standardized Achievement Test. Therefore it was decided to develop an Achievement Test in Environmental science to evaluate the elementary class students' knowledge, comprehension and application on the topics selected for treatment. A study of research and non-research literature motivated and helped to reflect on the use of multimedia. The professional experience and expert opinion helped to develop the Achievement Test.

Achievement Tests were prepared for all the five Multimedia Packages consisting of 123 multiple choice questions in total and after try out, the final draft has 75 questions. This test covered all the important aspects of the lessons taught in the class to the control group and experimental group both. The elementary class students of experimental group and control group students were given printed achievement test and answer sheets. The following steps were followed for developing the tests:

i) Planning of the Tests: The planning stage of a test should include the nature of the test items and the statement of conditions under which it will be administered. The Achievement test was planned with the objective of measuring achievement in Environmental Science of elementary class students on selected topics. For the planning of Achievement test following points were taken into account: Determining the purpose of test;
Identification and defining the intended learning outcomes; and constructing relevant test items.

Steps of preparing Achievement Test:
1. Instructional objectives
2. Design
3. Blueprint

Instructional objectives of the Test:
Achievement Test helps to measure the present level of performance of individuals or groups in academic learning. It also proposes to measure how much students have learnt as a result of instruction. For the purpose of constructing Achievement Test, objectives were defined in behavioural terms from selected units of Environmental Science syllabus of Grade VI. Since the major concern here was to test the academic achievement, accordingly, it was decided to test the three major areas of cognitive domain i.e. knowledge, understanding and application. After determining objectives, the learning outcomes were stated as observable terminal performance. The objectives in the cognitive domain are:
- To help acquire knowledge of the immediate environment.
- To help understand the biotic and a biotic environment.
- To help diagnose the different causes of environmental pollution and to suggest remedial measures.

Content of the Test:
1. Understanding Our Environment
2. Living and Non-living things
3. Natural Resources
4. Water
5. Pollution

To decide the weightage to be given to different content area, objectives and different forms of questions, expert opinions were taken into considerations.
Preparation of the Test Items:

123 objective type items with wide range of difficulty were constructed from five chapters of environmental science for elementary class students. Items were prepared in conformity with the Blue-print. While constructing items, it was ensured that no objectives remained untested and language of the test item was understandable and the instructions were clear. The test items were arranged properly in order of difficulty. The test items were arranged properly and assembled into the test.

The preliminary draft of Achievement Test was given to the school teachers who teaches environmental science to elementary classes. They were requested to give their opinion about the language and appropriateness of the items. Only those items were selected which were having 80% unanimity. Items having difficult language were modified to simple language, finally 75 items constituted the final Achievement Test.

Preparation of Directions to Test Items:

Appropriate directions to test items were prepared. The directions were clear and concise, so that the elementary class students could understand them easily. As test was divided into sections, clear instructions were given in the beginning of each section. For objective questions, the control group students and experimental group students were instructed to write the correct response in the given answer sheet.

Preparation of Directions for Administration:

A clear and detailed direction as to how the test is to be administered was provided in the booklet.

Preparation of Directions for scoring:

To facilitate the objectivity in scoring, scoring keys were prepared. Scoring Keys were prepared separately for 5 topics of Environmental Science.
First Try-Out

The test was administered to 50 students of class VI. Discriminating Power (D.P.) was computed for each item after forming top 27 percent and bottom 27 percent group from the total subjects as suggested by Kelley (1939). The blue print of the first draft of Achievement Test and distribution of discriminating powers was as seen in Table 4.2 & 4.3.

Q1 = Knowledge
Q2 = Comprehension
Q3 = Application

Table 4.2 - Blue Print of First Draft of Achievement Test

<table>
<thead>
<tr>
<th>Chapters</th>
<th>Cognitive Level of Objectives</th>
<th>Total Items</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Q1</td>
<td>Q2</td>
</tr>
<tr>
<td>Understanding Our Environment</td>
<td>11</td>
<td>10</td>
</tr>
<tr>
<td>Living and Non-living things</td>
<td>07</td>
<td>08</td>
</tr>
<tr>
<td>Natural Resources</td>
<td>10</td>
<td>08</td>
</tr>
<tr>
<td>Water</td>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td>Pollution</td>
<td>9</td>
<td>10</td>
</tr>
<tr>
<td>Total</td>
<td>46</td>
<td>45</td>
</tr>
</tbody>
</table>

The following formula is used to find difficulty level of each item of the Test.

\[
DL = \frac{Ru + R_1}{Nu + N_1}
\]

Where,
Ru = the number of students in the upper group who responded correctly.
R1 = the number of students in the lower group who responded correctly.
Nu = Number of students in the upper group.
N1 = Number of students in the lower group.
Discrimination power is estimated using the following formula:

\[
D.P = \frac{Ru - Rl}{Nu OR Nl}
\]

Table 4.3

Distribution of Discriminating Powers (D.P.) of items of First Draft of Achievement Test

<table>
<thead>
<tr>
<th>Discriminating Powers</th>
<th>Frequency</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.40 and above</td>
<td>47</td>
<td>Very Good Items</td>
</tr>
<tr>
<td>Between 0.30 and 0.39</td>
<td>28</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>Between 0.20 and 0.29</td>
<td>21</td>
<td>Needs Improvement</td>
</tr>
<tr>
<td>&lt; 0.19</td>
<td>27</td>
<td>Very Poor</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>123</strong></td>
<td></td>
</tr>
</tbody>
</table>

The revised version of the achievement test was administered to another group of 50 Elementary Class students again. Discriminating Power of 75 items was computed. The distribution of discriminating powers can be seen in Table 4.3.

Table 4.4

Distribution of Discriminating Powers (D.P.) of items of Final Draft of Achievement Test.

<table>
<thead>
<tr>
<th>Discriminating Powers</th>
<th>Frequency</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.40 and above</td>
<td>47</td>
<td>Very Good Items</td>
</tr>
<tr>
<td>Between 0.30 and 0.39</td>
<td>28</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>Between 0.20 and 0.29</td>
<td>--</td>
<td>Needs Improvement</td>
</tr>
<tr>
<td>&lt; 0.19</td>
<td>--</td>
<td>Very Poor</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>75</strong></td>
<td></td>
</tr>
</tbody>
</table>

In the light of the results as seen in Tables 4.3 and 4.4, out of 123 items, items below the discriminating power of 0.30 were dropped and 75 items were retained. These items were improved with respect of languages and description. This led to the preparation of final draft of the achievement test. This draft of achievement test comprised of 75 items. The Table of
specifications of blue-print for achievement test and the numbers of retained items are shown in Table 4.5 & 4.6.

Table 4.5  
Blue Print of Final Draft of Achievement Test

<table>
<thead>
<tr>
<th>Chapters</th>
<th>Cognitive Level of Objectives</th>
<th>Q1</th>
<th>Q2</th>
<th>Q3</th>
<th>Total Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Understanding Our Environment</td>
<td></td>
<td>7</td>
<td>4</td>
<td>4</td>
<td>15</td>
</tr>
<tr>
<td>2. Living and Non-living things</td>
<td></td>
<td>4</td>
<td>4</td>
<td>7</td>
<td>15</td>
</tr>
<tr>
<td>3. Natural Resources</td>
<td></td>
<td>7</td>
<td>6</td>
<td>2</td>
<td>15</td>
</tr>
<tr>
<td>4. Water</td>
<td></td>
<td>6</td>
<td>6</td>
<td>3</td>
<td>15</td>
</tr>
<tr>
<td>5. Pollution</td>
<td></td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>15</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>29</td>
<td>25</td>
<td>21</td>
<td>75</td>
</tr>
</tbody>
</table>

Table 4.6  
Number of items retained in the Final Draft of Achievement Test at different cognitive levels of objectives

<table>
<thead>
<tr>
<th>Cognitive levels of objectives</th>
<th>Serial Number of items retained</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Level</td>
<td>Ch. 1 1, 2, 10, 11, 13, 14, 19</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Ch. 2 1, 5, 12, 15</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Ch. 3 1, 4, 7, 14, 16, 17, 18</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Ch. 4 3, 11, 16, 17, 18, 20</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Ch. 5 1, 10, 11, 17, 18</td>
<td>5</td>
</tr>
<tr>
<td>Understanding Level</td>
<td>Ch. 1 3, 4, 5, 16</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Ch. 2 3, 7, 10, 17</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Ch. 3 2, 3, 8, 9, 13, 20</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Ch. 4 1, 4, 6, 7, 14, 19</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Ch. 5 4, 7, 13, 15, 20</td>
<td>5</td>
</tr>
<tr>
<td>Application Level</td>
<td>Ch. 1 2, 18, 21, 22</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Ch. 2 8, 13, 14, 16, 18, 19, 20</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Ch. 3 5, 11</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Ch. 4 10, 13, 15</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Ch. 5 1, 5, 9, 12, 19</td>
<td>5</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>75</td>
</tr>
</tbody>
</table>
Standardization of Achievement Test

75 items constituted the final form of the Achievement Test. The Achievement Test was further standardized by experimental validation of the test that included establishing reliability and validity.

Reliability of the Test

It is the degree of consistency between two measures of the same test. The reliability of a test refers to the extent to which a test measures consistently from one administration of the test to another. According to Fraenkel & Wallen (1993) reliability refers to the consistency of the scores obtained as how consistent they are for each individual from one set of items to another. The reliability of the test was measured by test-retest method. The coefficient of the Reliability of the test was measured by test-retest method of the five test presented in the Table 4.7.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Reliability Coefficient</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Understanding Our Environment</td>
<td>0.81</td>
</tr>
<tr>
<td>2. Living &amp; Non-living things</td>
<td>0.79</td>
</tr>
<tr>
<td>3. Natural Resources</td>
<td>0.73</td>
</tr>
<tr>
<td>4. Water</td>
<td>0.81</td>
</tr>
<tr>
<td>5. Pollution</td>
<td>0.88</td>
</tr>
</tbody>
</table>

The co-efficient of the Reliability for the whole test as found by test-retest method was 0.80 which indicates that the test is highly reliable. According to Fraenkel and Wallen (1993), reliability coefficients of 0.70 or higher are acceptable for research purpose. The reliability co-efficient of the present test was 0.80. Therefore, the achievement test may be considered fairly reliable.

Validity of the Achievement Test

Validity is a concern for the relationship between, the purpose set to achieve, on the one hand, and the efforts made, the means employed and what these efforts and means actually achieve, on the other. The Validity of the
Achievement Test constructed for the study was taken for granted because this is in accordance with Guilfor (1971) who said, “There are some measures whose validity is taken for granted, for example, Achievement Test scores.”

Content Validity

Regarding the method of establishing the validity of the test, Mouly (1970) stated, ‘At the most elementary level, it is necessary for all the test’ to have content validity, i.e., each question must be related to the topic under investigation, there must be an adequate coverage of the overall topic, the question must be clear, unambiguous, etc. The most adequate approach to validation consists of checking the agreement between the responses elicited by the question against the criterion. The present achievement test was validated against the criterion of content validity. Content validity is the most important criterion for the usefulness of the test, especially of an achievement test. It is a measure of the match between the content of the test and the content of “teaching” that preceded it. The measure is represented subjectively by the researcher after a careful process of inspections comparing the content of the test with the objectives of the course of instruction. Thorndike (1975) maintained that problem of content validity is parallel to the problem of preparing a Blue print for a test and then building a test to match the Blue-print. So, the Achievement test was found to possess Content Validity as there was correspondence between the table of specifications and test items.

Construct Validity

Construct Validity refers to an analysis of “effective expression” of items in the test. Selection of ideas to be presented, organization of ideas for presentation, paragraphing, writing effects sentences, effective use of words, form and style to message are the main components for analysis of effective expression (Thorndike and Hagen; 1955).

In the present study the investigator organized the ideas of the selected topic in a logical order and gave adequate representation to all the concepts. The style and language of sentences were simple. Effective use of words was
made by selecting the precise meaning and variety. Narration in proper style with simple words constituted easily readable and comprehensible sentences. Thus the achievement test prepared by the investigator fulfilled the requirements for effective expression. Hence the test has good construct validity.

**Final Form of the Test**
The final form of the Achievement Test on Environmental Science contained 75 items, along with a scoring key (Appendix F).

**4.4 ATTITUDE SCALE TOWARDS ENVIRONMENTAL SCIENCE**
The present tool "Attitude scale towards Environmental Science purports to measure the extent and degrees of awareness of elementary class students about the environment. Attitude is the degree of positive or negative effect associated with some psychological object. According to Thurstone, "psychological object" means symbol, phrase, idea, person and institution towards which people can differ with respect to positive or negative feelings. Attitude in this study is operationalised as the degree of positive or negative feeling of elementary class students towards the Environment. The method of summated rating suggested by Likert (1932) was followed in the development of scale. This scale also helps in studying the role of MMPs in changing the behavior of elementary class students towards environment.

**OBJECTIVES OF THE ATTITUDE SCALE:-**
To find the effectiveness of MMP for elementary class students towards Environment, the Attitude scale covered the following areas of the Environmental Science.

- Concern about environment and associated problems.
- Responsibility towards environment.
- Influences of human activity on environment.

**DEVELOPMENT OF ATTITUDE SCALE**

**Step 1: COLLECTING AND EDITING OF STATEMENTS:-**
A total of 72 statements that seemed to measure the attitude of elementary class students towards environment were selected through available literature
by browsing the Internet. In consultation with subject experts of Environmental Science, 17 statements have been reframed and 07 statements were deleted for overall ambiguity.

**Step 2: PREPARATION OF THE PRELIMINARY FORM OF THE SCALE**

Considering the above criteria, a total number of 65 statements were retained in the preliminary form of the tool. Out of 65 statements, 39 statements are positive and 26 statements are negative. Those statements were placed together on three point rating scale.

**Step 3: TRY OUT**

The preliminary form of the scale and answer sheets was administered to a try out sample of 50 elementary class students. Administered tools were collected and scored according to the scoring key. The students were asked to indicate their degree of agreement with each statement on the three point rating scale using classifications like “Agree”, “Undecided” and “Disagree”. For the measurement of attitude of students, scores for each statement were assigned 1, 0 and 0 to positive statements and for the negative statements score will be vice versa i.e. 0, 0 and 1. The following steps were considered for developing the attitude scale.

**Step 4: ITEM ANALYSIS**

Item analysis was done by using extreme group comparison method. Response frequencies along with assigned values for the statements were tabulated on a master sheet. Then total scores of the students were examined carefully. After that these scores were arranged in descending order (the highest score was placed on the top and lowest score was placed in the bottom). Then from the total cases, top 27% and bottom 27% cases were taken to form two groups. The percentages of the scores of two groups were calculated item-wise. Discriminating index of each item helps in preparation of final form of the tool. Only those statements were retained in which discriminating index is either equal to or greater than 0.30 and less than 0.80.
Step 5: PREPARATION OF THE FINAL FORM OF THE TOOL

After rejecting the unsuitable statements through item analysis, only 35 statements (including 28 positive and 7 negative) were retained for the final form. Out of 65 statements in the preliminary form, 30 statements were rejected because the Discriminating indexes were not significant. The discriminating index of each item is shown in the Appendix-G. Number of items with Discriminating Index of Attitude Scale is present in Table 4.8.

Table 4.8
Distribution of Discrimination Index of items of final draft of Attitude scale.

<table>
<thead>
<tr>
<th>Sr. No.</th>
<th>Discrimination Index</th>
<th>Serial number of items</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Below 0-0.30</td>
<td>4,5,9,10,15,16,17,24,25,26,31,32,33,36,37,41,42,43,47,48,49,50,52,53,54,57,58,59,62,63,64,65</td>
<td>Poor items to be rejected</td>
</tr>
<tr>
<td>2</td>
<td>0.30 - 0.60</td>
<td>1,2,6,7,8,11,12,14,18,19,20,21,23,27,28,29,40,45,46,51,56,61</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>3</td>
<td>0.60 - 0.80</td>
<td>3,13,22,38,44,55,60</td>
<td>Very Good</td>
</tr>
</tbody>
</table>

Step 6: STANDARDIZATION OF THE SCALE

The validity and reliability was ascertained for standardization of the scale. Reliability was measured by test - retest method.

Reliability:

Test-retest method: The final set of the 35 statements, which represent the attitude of elementary class students towards environmental science was administered to 50 students, which were not included in the actual sample. After a period of 15 days the scale was again administered to the same students and thus two sets of scores were obtained. The correlation coefficients for both the sets were worked out. The ‘r’ value was 0.95 which indicating the attitude scale was highly suitable for administration to the elementary class students as the scale was stable and dependable in its measurement.
Validity of the scale:

The content validity of the scale was tested. The content validity is the representative or sampling adequacy of the content, the substance, the matter and the topics of a measuring instrument. This method was used in the present scale to determine the content validity of the scale. As the content of the attitude was thoroughly covered the entire portion of environmental science through literature and expert opinion, it was assumed that present scale satisfied the content validity. As the scale value difference for almost all the statements included had a very high discriminating value, it seemed reasonable to accept the scale as a valid measure of the attitude. Thus ensuring a fair degree of content validity.

4.5 OPINIONNAIRE FOR TEACHERS (Validation of Multimedia Package):

Opinionnaire - Opinionnaire refers to a formal statements or estimation of professional advice. In the context of the present study, the Opinionnaire aids the researcher in assessing the effectiveness of Multimedia Package in items of content, presentation and its utility for Teachers. It also helps in studying the role of MMPs in creating the learning readiness, monitoring learning process, diagnosing learning difficulties. It also helps in evaluating the acceptability of MMPs by Teachers to further judge the effectiveness of the Multimedia Package as compared to traditional method of teaching. The researcher was not able to locate any appropriate opinionnaire based on MMP catering to the topics selected for the study. Hence it was decided to develop an opinionnaire for Teacher to seek their opinion on the MMPs.

An opinionnaire was developed to elicit the opinions of the teachers to determine the effectiveness and the acceptability of the Multimedia in teaching Environmental Science. An Opinionnaire consists of items with three alternative responses at the 3 point rating scale (Agree, Disagree and Undecided) i.e. a score of 1, 0 and 0 were assigned to alternative responses respectively. At the end of the opinionnaire, a column for remarks was made. The opinionnaire was submitted to the ten experts along with the design of the Multimedia Package for establishing the validity. The format was
accepted by the experts. The opinion of Teachers teaching at Environmental science was obtained.

Development and Description of Opinionnaire

The Teacher is considered the pivot upon which lies the success or failure of an educational programme. The opinionnaire was meant to obtain the information about the effectiveness of the Multimedia Package for Elementary Class for teaching Environmental Science.

The following criteria were delineated for multimedia package evaluation:

The evaluator criteria of Multimedia Package

i) Content characteristics
ii) Instructional characteristics
iii) Technical characteristics
iv) Management characteristics

i) The evaluator criteria of Multimedia Package

i) Content Characteristics: The presentation of content was viewed from the aspects;
   a) The appropriateness of content,
   b) Extensive uses of examples and illustrations to clarify content,
   c) Appropriate language, etc.

ii) Instructional Characteristics: The methods, strategies, etc. focused upon delivering content were considered as follows;
   a) Logical presentation of the content,
   b) Motivation,
   c) Ability levels of students,
   d) Self-pacing, etc.

iii) Technical Characteristics: Some techniques used in enhancing the learning competence of students as;
   a) Screen display of content,
   b) Graphics/animation,
   c) Music,
   d) Video, etc.

83
iv) Management Characteristics: Deal with management characteristics such as; case in use of MMP, test items, etc.

![Diagram of Multimedia Package Criteria]

**The Opinionnaire comprised of two parts**

**Part A** - aimed at eliciting information from the Teachers with regard to Name, Sex, Age, Education Qualifications, Professional Qualifications, Designation, Name of the School, Teaching Experience, Subject taught, Classes taken, Teaching Background and Methodology used by them in the class room.

**Part B** - was meant for obtaining information regarding the Multimedia Package used and their opinions on the various aspects, relevance and effectiveness of the Multimedia Package for Teachers.

The following steps were taken for developing the opinionnaire:

**Planning the test**

Planning stage of framing opinionnaire focuses on the areas to be covered by the opinionnaire which may also include the listing of items and the objectives for the opinionnaire. This stage was very important because it threw light on the core areas of MMP. The opinionnaire under reference was planned for the Teachers teaching Environmental Science with the objective of seeking their opinion on the statements on Multimedia Package of elementary class students. The planning of opinionnaire aims at:
* Determining the purpose of opinionnaire
* Identifying and defining the intended teachers' opinions.
* Preparing the opinionnaire specifications and
* Constructing relevant items for the opinionnaire

For constructing Opinionnaire, the objectives were outlined from the MMPs of selected topics of Environmental Science of elementary class students. The major concern was to seek the opinion of the Teachers.

**Objective of the Opinionnaire**

To find out the effectiveness of MMP, the opinionnaire covered the following areas of the MMP.
* Content
* Presentation
* Benefits to students
* Benefits to teachers

**PREPARATION OF OPINIONNAIRE ITEMS AND FIRST TRY OUT**

**Construction of statements** - The following steps were followed in constructing items for the opinionnaire:

**Development of statements** - A set of questions that on the face of it seemed to measure the relevant concepts were selected to reflect orientation to the Multimedia Package evaluation. A total of 44 items encompassing the four criteria were submitted to teachers of environmental science and computer teachers. They were requested to judge the items in term of:

i) Whether any important aspects of multimedia package evaluation were left uncovered.
ii) Whether the items were relevant and suitable for realizing the objectives of the study.
iii) Whether any of the items could be improved by rewriting.
iv) Whether some new items needed to be added.

44 statements were framed to elicit the views of teacher educators on a three-point rating scale. The preliminary draft of opinionnaire was framed and given to 5 teachers of environmental science after showing the MMPs. They were requested to give their opinion about the language and appropriateness
of items, based on the MMP. Only those items were selected which were having 80% unanimity. 39 statements constituted the Opinionnaire after first try-out.

As the Table 4.9 has shown that if discrimination index is either equal to or greater than 0.30 (> 0.30) than the item discriminate otherwise not. So, the investigator selected the statements discrimination index of 0.30 or above.

Table 4.9
Interpretation of discrimination index of each item of opinionnaire

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Discrimination Index</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Below 30%</td>
<td>Poor items to be rejected</td>
</tr>
<tr>
<td>2.</td>
<td>30% - 60%</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>3.</td>
<td>60% - 80%</td>
<td>Good Discriminator</td>
</tr>
<tr>
<td>4.</td>
<td>80% - 100%</td>
<td>Best Discriminator</td>
</tr>
</tbody>
</table>

Table 4.10
Discrimination index after first try out shows 39 items above 30%

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Discrimination Index</th>
<th>Item No.</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Below 30%</td>
<td>4, 27, 40, 41</td>
<td>Poor items to be rejected</td>
</tr>
<tr>
<td>2.</td>
<td>30% - 60%</td>
<td>1, 2, 6, 9, 10, 11, 12, 18, 21, 23, 24, 25, 28, 30, 32, 34, 35, 37, 38, 39, 42</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>3.</td>
<td>60% - 80%</td>
<td>5, 7, 8, 14, 16, 19, 20, 29, 31, 33, 36, 43</td>
<td>Good Discriminator</td>
</tr>
<tr>
<td>4.</td>
<td>80% - 100%</td>
<td>3, 13, 15, 17, 22, 26, 44</td>
<td>Best Discriminator</td>
</tr>
</tbody>
</table>

SECOND TRY-OUT
The opinionnaire was tested and tried out with a group of another 10 teachers. Out of 39 statements another 2 were rated below the acceptability level, while 37 statements were selected for the final draft. The blue-print of the final draft of opinionnaire and distribution of discriminating powers is given in the Table 4.11.
Table 4.11

Discrimination Index after Second Try Out

Shows 37 Items above 30%

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Discrimination Index</th>
<th>Item No.</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Below 30%</td>
<td>4, 27, 40, 41, 42, 43, 44</td>
<td>Poor items to be rejected</td>
</tr>
<tr>
<td>2.</td>
<td>30% - 60%</td>
<td>1, 2, 6, 9, 10, 11, 12, 18, 21, 23, 24, 25, 28, 30, 32, 34, 35, 37, 38, 39</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>3.</td>
<td>60% - 80%</td>
<td>5, 7, 8, 14, 16, 19, 20, 29, 31, 33, 36</td>
<td>Good Discriminator</td>
</tr>
<tr>
<td>4.</td>
<td>80% - 100%</td>
<td>3, 13, 15, 17, 22, 26</td>
<td>Best Discriminator</td>
</tr>
</tbody>
</table>

Final form of Opinionnaire

i) After going through 2 try outs, the final form of opinionnaire has 37 statements (Appendix H).

Table 4.12

Distribution of Final Items in opinionnaire

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Category</th>
<th>No. of Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Content Characteristics</td>
<td>09 Items</td>
</tr>
<tr>
<td>2.</td>
<td>Instructional Characteristics</td>
<td>16 Items</td>
</tr>
<tr>
<td>3.</td>
<td>Technical Characteristics</td>
<td>05 Items</td>
</tr>
<tr>
<td>4.</td>
<td>Management Characteristics</td>
<td>07 Items</td>
</tr>
</tbody>
</table>

Open ended questions were included at the end of opinionnaire to enable the Multimedia Package evaluators to identify overall strengths and weaknesses of the Multimedia Package.

On the basis of 2 tryouts the Investigator categories each item according to their discrimination index as shown in the Table 4.11.
Reliability - The reliability is the property of an item which reflects its consistency. If the same opinionnaire is given second time, similar results must be achieved. The present form of opinionnaire stood firm on the two trials. The reliability of the opinionnaire was measured by test-retest method. The co-efficient of the reliability, as found by test-retest method, was 0.91 which indicates that the opinionnaire is highly reliable.

Validity - Validity of a test or opinionnaire is the extent to which it measures what is attempted to be measured. This implies that the opinionnaire here should conform to the objectives of the testing. It was found that the statements of the opinionnaire were framed with the objective to seek the opinion of the teachers on MMPs. The opinionnaire was given to 4 Environmental Science experts and they made few suggestions which were incorporated, but it was widely accepted by the experts and the response from teacher further established the validity of the opinionnaire. The present opinionnaire is reliable, valid, covers all the elements catering to the objective, length of the opinionnaire is optimum, it is easy to administer, has scorability and above all its comprehensiveness takes care of all the aspects and nothing goes unescaped.

After the final draft was accepted these opinionnaires were filled up by the teachers providing the required information in different columns. Teachers were required to provide answers to the questions where some information is sought by writing in the space provided for it. They had to tick the right column where their opinion was sought. They had to tick one of these columns (agree/ disagree/ undecided) as per their choice. The teachers were requested to make information as elaborate and descriptive as possible to enable to understand the effectiveness of the Multimedia Package and for Further planning new inputs and improvement of existing Multimedia Package of environmental science.

Their comments were sought on the issues like-the strong points and the weak points/problem areas of this Multimedia Learning Package and their suggestions for making this Multimedia Learning Package better in future.
4.6 DEVELOPMENT OF MULTIMEDIA PACKAGE

This is the heart of the whole research thesis. It focuses on the actual multimedia cocktailing of elements (text, audio, video, animation and graphics) that is combining all the elements of multimedia together and delivering them in one go. It also highlights the development of Multimedia Package (MMP) and its various stages. Since no syllabus based, MMPs were available, so the investigator decided to develop the Multimedia Package on her own. The development of MMPs was a rigorous process and it had 3 major stages.

4.6.1 MULTIMEDIA PACKAGE DEVELOPMENT STAGES

Step- I Development of Multimedia Package

Development of Multimedia Package included the following three major stages.

1. Concept
2. Design
3. Production

![Multimedia Package Development Stages](image)

Figure 4.2 Multimedia Package Development Stages

I. Concept Phase (First Stage)

Every programme and project begins with a concept, so MMP is no exception. An MMP concept is the concise definition of the programme that can be designed and produced as per the specific requirement of the target group.

A clear concept is important because it lays foundation for an effective Multimedia Package. Hence changing the concept during any subsequent stages can turn disastrous. So the researcher needed to be very clear about the
concept because any change at later stage could have altogether altered the direction and constitution of the Multimedia Package.

<table>
<thead>
<tr>
<th>Some Basic Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>What will it be about?</td>
<td>Syllabus</td>
</tr>
<tr>
<td>What should it be called?</td>
<td>Title of the MMP</td>
</tr>
<tr>
<td>Who will be the user?</td>
<td>Students</td>
</tr>
<tr>
<td>What do we want to give the user?</td>
<td>Knowledge, Understanding, etc</td>
</tr>
<tr>
<td>How will create interest in the user?</td>
<td>Through Elements-Text, Animation etc</td>
</tr>
</tbody>
</table>

Figure 4.3 Basic questions at Concept stage

**Some basic questions asked at this stage were**

1. What will it be about? (Syllabus e.g. Environmental Science)
2. What should it be called? (Title of the MMP e.g. Understanding Our Environment)
3. Who will be the user? (Students of Class: VI)
4. What do we want to give the user: (knowledge, understanding and application)
5. How will create interest in the user? (elements-text, animation, graphics or audio to encourage exploration).

**Significance of Plan Approach at Concept Stage**

The Concept phase was crucial because it had impact on both design and production and the overall shape of the proposed Multimedia Package. So careful thought was given to the implications of the concept, for instance, including heavy layering or extra information was avoided, since it could lead to problems at the designing and production stage. Design directly gets affected by any inclusion or exclusion of tests and graphics thereby affecting the production which may over extend itself as resourcing and configuration issues also arise because of any additional
considerations at the concept stage. It is always recommended that a clear plan approach should be undertaken.

Thus a clear plan approach was undertaken by the researcher incorporating the following points at the Concept Stage:

* Aims and objectives of the MMP
* MMP length and duration
* Selection of the title
* Brief content outlines
* Writing of Instructional objectives
* Outline of proposed methodology was framed.
* Description of proposed application (format, media, etc.)
* Content levels (e.g. general, specific as per syllabus)
* Target audience-(e.g. class or level of students)
* Budget-(e.g. expenditure in developing MMPs)

So it is the proper development and the understanding of the concept that stands behind every successful MMP apart from skills and resources.

2. **Design Phase (Second stage)**

Design is a complex area in the development of Multimedia, however it is often recommended to keep the design simple and adhere to usability guidelines wherever possible. This means that design elements must be comprehensible and support the drive for user intuitiveness. Consistency is also essential for design. Any design features should adhere to usability
standards. So an utmost care was taken in keeping the consistency at all steps.

Following points were taken care of while designing the Multimedia Package:

List of actions addressed at the Design Stage:

* Designing a script
* Storyboard, the content and screen elements were short listed.
* Media type, format, standards were specified.
* Flowchart of components was constructed.
* Images, graphics, Animation items, Audio and Video to be included were decided.
* Consistency in layout (e.g. design, colour, etc).
* Consistency in terminology was maintained (e.g. commands).
* Consistent titling/headers were done.
* Font size was made readable.
* Content layout was kept sensitive to screen size/view area.
* All images had descriptive alternative text (e.g. ALT tags in web).
* Simple background colours were used to allow enough contrast for users with vision disability.
* Video and audio clips had text equivalent.

Elements of a Good Script for a Multimedia Package

Following points were taken care of by the researcher while writing the script of MMPs:

❖ An attractive start
❖ Clarity of concept
❖ Objective based content
❖ Known to unknown approach
❖ Interactive in nature
❖ Simple language
❖ No tricks
❖ Easily understandable technique
❖ No ambiguity
❖ Smooth transition
3. **Production Phase** (Third stage)

The production period is dependent on the concept and design processes; being harmonized through agreement in appropriate resourcing, scoping and development time. It was thus essential to plan out the issues of workflow, and that the researcher recognized the projected deliverables and outcomes in the production stage, in the light of objectives desired at concept stage. Mapping of milestones was done and activities were minutely monitored. Additionally, a post-production period was included in the overall development plan for quality assurance, testing and evaluation. So Production stage was the stage of implication.

The Production phase, including post-production, had taken into consideration the following:

- Production of MMPs including visual, audio, animation, graphics and video
- Mapping milestones
- Workflow, Progress reporting and monitoring
- Testing with target audience
- Evaluation (production and post-production)
- Incorporation of modifications on the basis of feedback
- Review processes to see the effectiveness of the programme
4.6.2 STEPS IN DEVELOPMENT OF MULTIMEDIA PACKAGE

The following list provides an overview of the various stages that were crossed in developing MMP

I. Data Gathering
II. Navigation Method
III. Media Contents
IV. Interface Designing
V. Storyboard
VI. Authoring
VII. Data Delivery.

4.6.2.1 Data Gathering

Data Gathering was the first step and it included following phases -

* Information Collection
* Analysis and Filtering
* Organization
* Verification
Figure 4.7 Steps of data gathering

Stages - 1  **Information Collection** - At this stage the researcher collected all the information relevant to the MMPs. The required content information was collected from the books as per the syllabus of Grade VI and it was further enriched from the web and library. After collecting it was analyzed, filtered and organized.

Stage - 2  **Information, Analysis and Filtering** - Filtering is a process of deciding which information is reliable and authentic and which is not. At this stage two the researcher filtered the information and this helped in deciding the volume and depth of the information needed for the MMPs. Not all the information gathered was found useful for the MMPs. So the data needed to be edited, modified and even deleted altogether.

Stage - 3  **Data Organization** - The filtered data was keyed into computer for further processing. A blueprint of the MMP got ready. At this stage the researcher got a fair idea about how the MMP would be evolved in terms of the content. The information was organized in a logical and sequential manner. This stage was the backbone of the MMP development.

Stage - 4  **Data Verification and Authentication** - Once all the necessary information had been collected and organized, it was verified and authenticated as per the specifications of the syllabus and necessary corrections were made.
4.6.2.2 NAVIGATION METHOD

Linear structure approach was used for navigation. It is the simplest approach where the user moves through a sequential straight lined path, one part after another. Here the user had the option of moving one step upwards and backwards.

Figure 4.8 Navigation Method-Linear

4.6.2.3 MEDIA CONTENTS

Once the contents and navigation structure had been organized, the attention was paid to multimedia elements required for development of MMPs. These included elements of multimedia namely: audio, video, graphics, text and animation.

Table 4.13 Multimedia Elements and Contents

<table>
<thead>
<tr>
<th>Media Elements</th>
<th>Typical Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>Background music, background voice.</td>
</tr>
<tr>
<td>Video</td>
<td>Videos of Different type of pollutions, misuse of natural resources etc. are used in MMPs.</td>
</tr>
<tr>
<td>Text</td>
<td>In all MMPs content specific for title, main body and conclusions in all slides.</td>
</tr>
<tr>
<td>Graphics</td>
<td>Backgrounds, pictures, images. Widely used in all MMPs.</td>
</tr>
<tr>
<td>Animations</td>
<td>Used for titling and highlighting effects as used in all MMPs.</td>
</tr>
</tbody>
</table>
Multimedia Packages were developed using various elements of multimedia audio, video, text, graphics and animation.

![Elements of Multimedia Package (MMP)](image)

**Text:**

Text has played an important role in development of MMPs. The extent to which texts have been used in MMPs depended upon three major factors -
* The nature of the MMP (Understanding our environmental, Living and Non-living things, Natural resources, Water, Pollution)
* The subject/content (specific title and portion of the topic taken)
* The treatment of the subject/content (heavy graphics/ light graphics/ heavy text/light text)

Texts have been used in MMPs for different purpose -
* Title texts
* Body texts
* Menu
* Miscellaneous texts

The design rules that governed multimedia texts largely depended upon the context in which particular text appeared. In general the title texts were bigger in size and brighter in colours than the body texts.

Designing text involved two basic aspects of information that were - Content and display.
* Content covered the matter that was being presented.
* Display covered how that matter was being presented.

The three parameters that controlled the display design of multimedia texts were -
* Fonts
* Fonts colours
* Backdrop (background)
It was noticed that while the fonts affected the profile of the displayed texts, colours and backgrounds affected the overall appeal of the same.

**Graphics**

Graphics play a pivotal role in multimedia applications. The maxim 'a picture is worth a thousand words;' is so factual that one cannot underestimate the impact of visuals over plain text or audio, in the context of multimedia.

Graphics in multimedia represent a collective terminology that includes all kinds of still pictures like images, photographs and art works used in MMPs applications. It doesn’t include any entities with dynamics and movements-like animation and videos. Graphics used in MMP were characterized by certain attributes which made these MMPs effective.

* Graphics were kept as simple and appealing.
* They fittingly captured the mood of the title.
* They were designed and selected suitably to fit the overall theme of the design.
* They were even used as background image or moving from one concept to other.
* They were developed in exact concurrence with other forms of media presented like texts, video so that all these elements fitted together as one seamless stream of information.

Types of graphics imagery used in MMPs fall under any one of the following categories:

* Photograph (either scanned or digitally photographed)
* Clip arts (drawings drawn or taken from clip art files)
* Miscellaneous variety (all other types of images)

Graphics are important companions to information, when suitably presented. In present 5 MMPs 50% of space was dedicated to graphics and the rest was filled by textual information. Pictures can hold the attention of the viewers longer because of its interactivity and wide variety. Pictures have been used by the researcher to cover the various aspects of the selected topics.
Audio

Audio plays a vital role in the making of an MMP. In all the 5 MMPs audio has been widely used. It has been put in the form of natural sounds, music, dialogues and narrations. While developing these MMPs audio recording was a serious business and it needed great effort and expertise.

The three major steps of audio input are:

* Sound recording
* Sound editing
* Sound delivery

Step: I

SOUND RECORDING – Sound recording was done taking all the precautions like when microphone based recording was done, a place was selected with least noise disturbances from outside. The microphone was connected to the mic-in-jack of the sound card of the computer and the sound was recorded. After the recording got over the stop button was pressed and the sound file was saved on the computer using one of the media players.

Step: II

SOUND EDITING – Sound editing demanded even more expertise than the sound recording. Effective sound editing demanded a great deal of creativity and timing. It was the stage where all the errors of sound recording were noticed and corrected. The noise reduction was done in order to enhance the audio quality / volume or dullness in some places.

Step: III

SOUND DELIVERY: Audio has been delivered using MP3 or Microsoft WAV formats. Audio has served several purposes.

* It offered a commentary that supplemented text
* Audio files being smaller to load than video and proved less fidgety than video plug-ins.
So sound has been an essential element of Multimedia Packages. It was therefore, very important for the researcher to understand the nature of sound, its components and characteristics. By using commentary and powerful narration, combining the sound effects, music and dialogues, wonderful and fascinating pictures could be created.

Human voice especially the voice of children/teacher in the form of dialogues, narration, commentary or recitation has worked like magic and had made the Multimedia Package interesting and fascinating. Similarly the background music and suggestive music (happy, sinister depending upon the nature of the package) has made it more effective. Atmosphere sound effect, sounds of wind, birds or special noises etc. have been used to enrich and emphasize the impact and meaning. Thus sound has provided rich and enormous possibilities to enrich the teaching learning process.

Audio has been used in all the Multimedia Package and it has added to the effectiveness of MMPs.

**Video:**

Video has been delivered using media player. Video proved to be an effective supplement to text and images and provided enhanced experience. In the Multimedia Package Video clippings has been used to explain different topics.

**Animation:**

Animation is derived from the Latin word meaning “bring to life”. Rapidly changing the image on the screen to create the illusion of motion is called animation. In other words, modeled objects are brought to life in animation. Although animation is considered synonymous with motion, it covers all changes that have a visual effect. It thus includes the time varying position, shape, colour, transparency, structure and texture of an object. To animate something is, literally, to bring it to life. A computer based animation performed by a computer using graphical tools to provide visual effects.
Animation has been used by the researcher for:
* Showing concepts or states in transition
* Indicating dimensions
* Visualizing 3D structures

Educationists have found that children love animation by nature. In the Multimedia Package animation effect was added for explaining different concepts. It has also been used for achievement test. It was highly stimulating and brought in the feeling of participation in the learning package. The viewers were completely involved and remained active. It also helped in the retention of the viewers.

4.6.2.4 INTERFACE DESIGNING

At this stage, backgrounds and buttons to link slides was infused.

**Technical PowerPoint Vocabulary for Multimedia**

Every instructor who wants to develop multimedia programme needs to familiarize with the vocabulary of Microsoft power point. Following are the few common terms used throughout while developing an MMP (a Power Point presentation).

**Slide**: An individual screen in a slide show.

**Presentation File**: The file you save to disk that contains all the slides, speaker’s notes, handouts, etc. that make up your presentation.

**Object**: Any element that appears on a PowerPoint slide, such as clip art, text, drawings, charts, sounds, and video clips. You can refer to a clip art object, a text object, a title object, a drawing object, etc.

Anything you put on a PowerPoint Slide is called an object.
Slide Show: A series of slides displayed in sequences. A slide show can be controlled manually or automatically.

Transition: A special effect used to introduce a slide during a slide show. For example, you can fade in from black, or dissolve from one slide to another.

Development of Multimedia Package using PowerPoint

The toolbars helped the investigator perform various tasks

The toolbars contain graphically illustrated buttons that you click to perform specific tasks in a program. PowerPoint 97 has four main toolbars, which can help you create your presentations quickly and easily.

The Standard Toolbar is located at the top of the PowerPoint window, below the menu bar. It has buttons for common tasks such as saving, printing, checking spelling and inserting charts and Tables.
The *Formatting Toolbar* is located just below the standard toolbar. Most of its buttons are for formatting text. Use these buttons to change the font type or size, make text bold or italic, indent text, and insert bullets.

The *Drawing Toolbar* is located at the bottom of the PowerPoint window. It has tools for drawing shapes, adding lines and curves, and inserting text boxes and WordArt. It also has buttons for manipulating and formatting the objects you draw.

The *Common Tasks toolbar* is initially a floating toolbar. That is, it isn’t anchored to an edge of the PowerPoint window. Use this toolbar to create a new slide, change the layout of a slide, or apply a design.

---

**The investigator moved the toolbars to new locations**

All PowerPoint toolbars can be moved or docked to any side of the PowerPoint window. As well, docked toolbars, including the Standard
Toolbar, the Formatting Toolbar, and the Drawing Toolbar, can be converted to floating toolbars.

A move handle on the left or top of the toolbar indicates that the toolbar is docked. A title bar indicates that the toolbar is floating.

Here’s how to move one of the toolbars to a new location:

1. Clicking the move handle on a docked toolbar, or click the title bar on a floating toolbar.

2. Holding down the mouse button, drag the toolbar to the new location.

The investigator docked the toolbars to create more working area:

The investigator docked the Common Tasks toolbar to the top of the PowerPoint window. This will give you more working area on your PowerPoint window.

1. The investigator clicked the title bar on the Common Tasks toolbar.

2. Then dragged the toolbar upwards, until the toolbar outline snaps into place along the edge of the program window.

The handles that appeared on the toolbar confirmed that the toolbar had been successfully docked.
Adding and removing toolbars

PowerPoint has several other toolbars to help you accomplish your tasks.

The *Picture Toolbar* has several buttons that are useful when you work with images. There are buttons for contrast, Brightness, and Cropping. This toolbar will automatically appear when you insert clip art or pictures.

The investigator reached an advanced user stage and wished to add some of these toolbars to the PowerPoint window. Here are the steps taken by the investigator to add the animation effects toolbar.

1. The investigator clicked the View menu, and then point to Toolbars.

2. In the submenu, clicked the check box next to animation effects. An animation effect toolbar appeared in the PowerPoint window.
The following steps helped the investigator to remove a toolbar.

PowerPoint helped the investigator even remove toolbars which were not needed.

1. The investigator clicked the View menu, and then point to Toolbar.
2. In the submenu, clicked the check box next to animation effects to deselect it.

The check mark disappeared and the animation effects toolbar was removed from the PowerPoint window.

**Making a Multimedia Package**

The investigator created a *Title Slide* for MMP using the Blank Presentation option. The investigator worked in Slide View.

1. The PowerPoint program was opened. The PowerPoint dialog box appeared.
2. In the PowerPoint dialog box, the investigator clicked the Blank Presentation option button. The New Slide dialog box appeared. It asked to choose an Auto Layout format.
3. Then the Title layout was clicked. It was the first in the list. The name Title Slide appeared in the Preview box.
4. After clicking OK. A Title Slide appears, ready for you to work with.

The PowerPoint dialog box appeared only when the investigator first launch the program. When the investigator already working in PowerPoint and want to create a new blank presentation, then the New button on the Standard Toolbar was clicked and these steps were followed:

1. The investigator clicked the File menu, and then clicked New.

2. In the New Presentation dialog box, clicked Blank Presentation, and then clicked OK.

**Adding text to a slide**

The Title Slide layout contains text boxes for a title and a subtitle. The investigator typed Text into these boxes.

1. Clicked in the Title text box. A thick gray border appeared around the text box indicating that it was selected.

2. Typed a title.
3. Clicked the Subtitle text box and typed a subtitle.

Following steps were taken for Adding another slide
1. The investigator clicked the New Slide button on the Common Tasks toolbar.

2. Then the Auto Layout dialog box appeared and from there a layout was chosen for the next slide.

While developing MMPs, the investigator used a lot of text so choice of the right kind of font/its colour/size could make or mar a presentation.

Since a wide variety of fonts was available for experimenting, it was lots of fun to try out different fonts. Considering there were thousands of fonts out there, the investigator could end up making some pretty wacky choices for the MMPs. Making an entire MMP loaded with varied font’s might be fun for the creator, but it could end up being difficult - if not impossible - for the pre-service teachers, our audience to comprehend. For this reason, it was important to choose the fonts very carefully.

If a presentation contains a lot of text, it’s good to use a font such as Times New Roman which is known as a “serif” font. A “serif” is a small, decorative mark that finishes off the stroke of a letter. There are also other fonts called
“sans-serif” - which means: without serif. “Sans” - as you may recall from French class - means “without”. In general, it is easier to read a large amount of text when a serif font is used. Sans-serif fonts also tend to create a more casual, less-formal impression.

If you want to use different fonts within the same presentation, it’s best to keep it down to only two or three. Using a smaller number of fonts will keep things orderly; too many different types may make it all a bit too chaotic. Like so many things in life, you’ll just have to experiment before you know what works best.

When the investigator was trying to decide which fonts to use, consider how they will look on screen. It was found some fonts - like Verdana - tend to look better on a computer monitor. Other fonts are more suited to print. The investigator had to see if the font was visible on a computer screen or digital projector. The investigator also had to see if the font still looked good when the presentation was printed out.

**Moving from slide to slide**
To move to a previous slide, the investigator followed these steps:
1. By clicking the upper double-arrow button on the lower right corner of the PowerPoint window. The previous slide appeared.
To move to the next slide:
1. Clicked the lower double-arrow button on the lower right corner of the PowerPoint window.

**Switching to Outline View**
To switch to Outline View, the Outline View button in the lower left-hand corner of the PowerPoint window was clicked.

This is what the investigator saw in Outline View:
When the investigator moved to Outline View, PowerPoint automatically displayed an Outline Toolbar on the left side of the window. It contained many useful tools for working in the view.

This toolbar will automatically appear in Outline View.

Steps followed by the investigator for adding a slide to the outline

The investigator added a new slide in Outline View the same way as done in the Slide View.
2. In the New Slide dialog box, clicked a slide layout, then clicked OK. A new slide icon appeared in the outline.

1. PowerPoint in the Classroom
2. This icon tells you where you have added a new slide.

To add a new slide right after a slide title:
1. The investigator placed the cursor at the end of a slide title.
1. PowerPoint in the Classroom
2. This icon tells you where you have added a new slide.
2. Pressed the Enter Key. A new slide icon appeared in the outline.

Steps used by the Investigator for adding text to the outline

If the investigator wanted to add text to a slide that was created previously, she needed to click an insertion point in the outline and start typing.

If the investigator wanted to add text to a new slide that was created in Outline View, following steps needed to be pursued:

1. Typed a title the slide icon.
2. after the slide title needed to press the Enter key. PowerPoint added a new slide.
3. Clicked the button on the outline toolbar to convert the new slide to a text object.

   This button will change a new slide to a simple line of text.

4. Now the investigator could type the text.

   1. **PowerPoint in the Classroom**

   2. This icon tells you where you have added a new slide

5. To add another bullet point, pressed Enter.

With the exception of the title slide, any text added by the investigator was formatted as a bullet point.

The investigator could get the bird's eye view of the MMP by moving around in Outline View

In Outline View, the investigator could see all the text that appeared on the slides and could see all the outline titles in one shot. This option could also be used to print an outline of the presentation or for check the logical flow of your slide titles without the distraction of extra text.
To collapse all the slides in your outline, the investigator had to take these steps:

1. One the Outline Toolbar clicked the Collapse All button. The slide text for all the slides disappeared.

   ![Use this button to hide extra text](image)

To expand all of the slide titles again:

1. Clicked the Expand All button on the Outline toolbar. The text for all the slides appeared again.

   ![This button makes the hidden text appear again](image)

**Jumping from one slides to the next**

To move from one slide to another in Outline View, the investigator could click anywhere on the slide that she wanted to move to.

**The investigator kept on saving the Presentation at every step**

While working on a presentation, it’s a good idea to save your work often. Otherwise, there was risk of losing the work at any stage due to power failure or any other reason. The investigator kept on saving the work at every stage. The following steps were used to save the MMPs to the hard drive. When the investigator was saving for the first time the Save As command was used.

1) Clicked the File menu, and then clicked Save As. The Save As dialog box appeared.

   ![Use this command to save your presentation](image)

2) In the File name box, the investigator typed a name the MMP (presentation).
3) Clicked Save.

The presentation is now saved to the hard drive.

Once the investigator saved the presentation for the first time, periodically could save it by clicking the File menu, then clicking Save. Or, clicked the Save button on the Standard toolbar.

Avoid disaster. Save your presentation periodically

The AutoContent Wizard was used by the investigator for Creating MMPs.

First the investigator launched PowerPoint then clicked the AutoContent Wizard option button in the PowerPoint dialog box to start a presentation.

Following were the steps used to start the AutoContent Wizard:

1. clicked the File menu, then click New. The New Presentation dialog box appeared.

2. In the New Presentation dialog box, clicked the Presentation tab.

3. In the Presentation list, clicked the AutoContent Wizard, and then clicked OK. The wizard got started.

The investigator Worked with the AutoContent Wizard

The AutoContent Wizard guided the investigator through some simple steps.
1. The investigator read the information on the start screen, and then clicked next.

2. In the next dialog box, selected the type of presentation the investigator wanted to give, and then clicked Next to advance to the next dialog box.

What type of presentation are you going to create?

3. Continued entering options until reached the Finish step.


The AutoContent Wizard displayed the MMP in Outline View. The outline is made up of sample slides, each of which had a suggestion for the type of information that was to be entered in the slide. So the investigator customized the information in the slides in either Outline View or Slide View.

**Template used for developing MMPs**

A template, also called a presentation design, it helped the investigator to create a presentation without worrying about design elements. The template defines the color, background, and font of the slides. PowerPoint has many templates, which the investigator could preview and select in the New Presentation dialog box.

PowerPoint also allowed the investigator to customize the templates. For instance, the investigator could change the background color or typeface of a template. Investigator has used different templates for developing Multimedia Learning Package.


Creating a MMP using templates

After the investigator had just launched PowerPoint, the Template option button was clicked in the PowerPoint dialog to start a new presentation.

When the investigator was already working in PowerPoint, following steps were taken:

1. Clicked the File menu, and then clicked New. The New Presentation dialog box appeared.

2. Clicked the Presentation Designs tab, and then clicked an appropriate template. The design appeared in the preview box.

3. Clicked OK. The New Presentation dialog box closed.

Changing background colour of the slides in the MMPs

In PowerPoint it’s easy to change the background colour of the slide, the investigator was working on. If the investigator wanted to change the colour of the slide to light blue, here’s what she needed to do:

1. Clicked the Format menu, and then clicked Background. The Background dialog box appeared.
Select Background from the format menu

2. In the background fill section, clicked the arrow on the list box to open it.

3. Clicked more colors to open the Colors dialog box.

4. In the Colors section, clicked a light shade of blue.

5. Clicked OK to close the Colors dialog box.

6. In the Background dialog box, clicked the Preview button to saw a preview of the slide color.

Do you like what you see?
7. If the investigator liked what she saw, clicked the Apply button. The background colour of the slide was now light blue.

For Changing background pattern the investigator followed these steps:

1) Clicked the Format menu, and then clicked Background. The Background dialog box appeared.

2) Clicked the Background Fill list box, and then clicked Fill Effects. The Fill Effects dialog box appeared.

3) Clicked the Pattern tab, and then clicked the pattern, the investigator wanted in the Pattern box. A preview of the pattern appeared in the Sample box.

4. If the investigator wanted to change the background and foreground colors of the pattern, she had to select them from the Background and Foreground drop down lists.

5. Clicked OK to close the Fill Effects dialog box.

6. In the Background dialog box, clicked the Apply button.
The investigator had a wide range of colours available to choose from

When it came to text colours and background colours and patterns, the investigator had a dizzying array of choices. While it was possible to go crazy with them, it was best to stay on the more conservative side and create something the student's should actually read.

It was good to choose a high contrast between text and background colours. For example, black text and white background is most legible. Other good combos included white text on a dark blue or purple background or dark blue text on a yellow ground.

The investigator wanted to use backgrounds and also used patterned ones. For MMPs – Understanding our environment, Living and Non-living things, Natural resources, Water, Pollution, the investigator designed the templates using appropriate pictures. The investigator decided to keep the background pattern as suitable as possible. Very jazzy patterns were avoided by the investigator since they could have made it very difficult to read text and could make the pre service teachers confused.

Spellings checking by using PowerPoint spelling Checker.
It’s a good idea to check the spelling in our presentation before the audience sees it. The investigator used the PowerPoint’s spelling checker to check the presentation. When the spelling checker was activated, it checked the spelling in all the slides.

1. On the Standard toolbar, clicked the Spelling button.

2. If a spelling error was detected a Spelling dialog box appeared.

3. The Spelling Checker suggested an alternative spelling in the Change To box. An additional list of suggestions also appeared below the box.
4. If the investigator wanted to continue without changing the spelling, they clicked Ignore.

5. If the investigator wanted to change the spelling, they entered one of the suggested alternatives in the Change to box, then clicked Change.

After the investigator had made the selection in the spelling dialog box, the spelling checker continued checking the remaining slides. When it had checked all the slides in the presentation, a message box appeared telling that the spell check was complete.

**The investigator could even turn the automatic spelling checker off**

As the investigator typed, a red wavy line appeared under misspelled words. If the investigator wanted to correct the spelling immediately, then with a right-click of the mouse on the word, and a menu appeared suggesting spelling alternatives.

If the investigator didn’t want to see wavy red lines under misspelled words as they were typed, the automatic spelling checker could be turned off.

1. Clicked the Tools menu, and then clicked Options. The Options dialog box appeared.

2. Clicked the Spelling tab.
3. Under Check spelling as the investigator typed, clicked the Spelling check box to deselect it. The check mark disappeared.

![Remove the check mark from the box]

4. Clicked OK to close the Options dialog box. The automatic spelling checker got deactivated.

Even when the automatic spelling checker was turned off, the main spelling checker still worked. So the investigator could check the spelling in the presentation at any time by clicking the Spelling button on the Standard toolbar.

**The investigator had to decide about going for spell check or not to spell check.**

Spell Check should be done or not?

Using the spell checker was a good way to maximize the use of time- the most precious of resources. It was a pretty nice and comfortable to just sit back as the computer scanned the document. The downside was that the investigator might have used a wrong word - spelled correctly - and computer couldn’t point out such errors. The advantage of not using spell check was that it forced the investigator to be more careful about the spelling. So the spell checker was avoided by the investigator since it looked more like a crutch that could have left many words wrongly placed and spelled.

**Adding a new text box**

Sometimes, the investigator has to add text to a slide without using a built-in text box. For example, to type a label for a drawing, the investigator added text box using following steps:

1. On the drawing toolbar, clicked the Text Box button. The pointer changed to a cross.
2. Clicked on the slide where the investigator wanted to place in text. A small text box appeared.

3. Typed a word in the text box. As the investigator typed, the box expanded to fit the text.

4. After the investigator finished typing, clicked outside the text box. The border around the box disappeared.

**Moving a text box**

The investigator followed the following steps to move a text box:

1. Clicked the text box the investigator wanted to move. A thick gray border appeared around the text box.

2. Placed the pointer on the border. The pointer was changed into a four-headed arrow.

3. Hold down the mouse button and dragged the box to the new location.

4. Released the mouse button.

**Adding colour to a text box**

1. Clicked the text box to select it.

2. On the drawing toolbar, clicked the arrow beside the Fill Color button, and then clicked the green colour box. The text box turned green.
Changing the font
The investigator used following steps to change the font.

1. Clicked the text box to select it.

2. Placed the pointer on the box’s border, and clicked again. The insertion point disappeared, indicating that the entire text box was selected.

3. Clicked the Format menu, and then clicked Font. The Font dialog box appeared.

4. In the Font style list, clicked Bold; in the Size list, clicked 36; and in the color list, clicked green.

You can change everything all at once

122
5. Clicked OK to close the font dialog box.
All the text in the text box is now green, bolded, and a font size of 36.

Eye-catching isn’t it?

Adding a shape

PowerPoint lets you add a variety of shapes to the slides of your presentation. Adding a star shape to the slide, using the AutoShape tool on the drawing toolbar.

1. Clicked the AutoShapes button, point to Stars and Banners, and then click the 5-point star shape. The pointer was changed into a cross.

2. Clicked anywhere on the slide. A star of predefined size will be inserted.

The star looks huge, but don’t worry – you can resize it.

To make the shape larger (or smaller), drag a resizing handle. To resize the shape proportionally, hold down the SHIFT key as you drag.

Adding color and texture to a shape

Adding the colour yellow to the star.

1. Clicked the star shape to select it.
2. Clicked the arrow beside the Fill Color button, and then clicked More Fill Colors.

A Colors dialog box appeared.

![Colors dialog box](image)

This will open the Colors dialog box.

3. Clicked the Standard tab, then under Colors, clicked a shade of yellow.

![Add a little color](image)

4. Clicked OK to close the Colors dialog box.

![The star is now yellow](image)

Next, adding some texture to the shape:

1. Clicked the star to select it.
2. Clicked the arrow beside the Fill Color button, and then clicked Fill Effects. The Fill Effects dialog box appeared.
3. Clicked the Texture tab.

4. Clicked on a texture, and then clicked OK.

**What's your favorite pattern?**

Now that's one funky star!

**Adding clip art**

The investigator followed the following steps to add a cartoon image to the slide:

1. On the Standard Toolbar, clicked the Insert Clip Art button.

   ![Image of Insert Clip Art button]

   **Click this button to add clip art to your slide**

2. The Microsoft Clip gallery dialog box appeared.

3. Clicked the Clip Art tab.

4. In the Categories list, clicked Cartoons. PowerPoint displays clip art from the Cartoons category.

   ![Image of Clip Art gallery]

   **Click here to see the Cartoons category**
5. Clicked an image to select it.

6. Clicked the Insert button. The cartoon image was inserted on the slide.

Resizing clip art

Like text boxes and shapes, it was easy to change the size of a clip art image. Here’s how:

1. Clicked the cartoon image to select it.

2. Place the pointer on a resizing handle. The pointer changed into a tow-headed arrow.

3. While holding down the mouse button, dragged the mouse outwards to enlarge the image. If the investigator dragged the mouse inwards, the size of the image was reduced.

4. When the image was the size the investigator wanted, released the mouse button.
Adding a Transition

A transition is a special effect used to introduce a slide during a slide show.

The following steps were used by the investigator to add a transition to a slide.

1. In Slide Sorter View, clicked the slide the investigator wanted to add the transition to.

2. Clicked the Slide Show menu, and then clicked Slide Transition. A Slide Transition dialog box appeared.

3. In the Effect list box, clicked Checkerboard Across.

4. Clicked the Medium option button to select a speed for the transition.

5. Clicked the Apply button. A slide transition icon appeared under the slide’s left corner, indicating that the transition has been applied.

To apply the same transition to all the slides in the presentation, clicked the Apply to All button in the Slide Transition dialog box.
Timing a transition

To run slide show automatically, timing was added to the slides.

Here’s how the investigator added timing to the slides:

1. Selected the slides to add timing to by clicking it.
2. In Slide Sorter View, clicked the Slide Show menu, and then clicked Slide Transition. The Slide Transition dialog box appeared.
3. Under Advance, clicked the check box next to Automatically After.
4. In the second’s box, typed the number of seconds to remain on the slide. For example, 5 seconds.
5. Clicked the Apply button.

Adding Sound

There were different methods to add sound in PowerPoint. The investigator wanted to use her own voice and also wanted to add background music to it. So she chose to record her voice sound recorder and after mixing it with background music, added it to the PowerPoint.

The following steps were taken by the investigator to record her voice:

1. Launching Sound Recorder
   * In Window XP, navigated to Start > All Programs > Accessories > Entertainment > Sound Recorder.
   * When the Sound Recorder popped on-screen, the investigator noticed that it looks a bit like a tape recorder front panel.
   * In the center of the window was a flat, green line. As the sound played or records, this green line oscillates to visually represent the sound.
* To the left was the **Position** indicator, represented in hundredths of a second.

* To the right was the **Length** indicator, showing the total duration of the sound file.

* Below these features was a **Slide Bar** indicator that shows where the sound file was playing, relative to its overall length.

* Finally, located below the Slide Bar, the investigator saw the universal symbols (from left to right) for Rewind , Fast Forward , Play , Stop , and Record.

![Image of Sound Recorder interface]

### 2. Setting the Microphone Record Level

Before beginning recording, the investigator checked the microphone settings for a proper volume level.

1. After starting Sound Recorder, clicked on Edit Audio Properties.
2. In the Audio Properties dialogue box, under the Sound recording section, checked to see that the sound card was the Default device.
3. Below the Default device, clicked on Volume.
4. In the Recording Control dialogue box, the investigator selected the microphone as the recording source, and turned its volume up full.

129
5. Closed the dialogue box and returned to the Audio Properties box.
6. Clicked OK.

3. Recording a Sound

To record and play audio, the investigator needed a sound card, a microphone, and speakers or headphones. To record the voice, the investigator hooked the microphone into the audio-in-jack on the computer’s sound card.
2. To begin recording, clicked and speak into the microphone.
3. To stop recording, clicked.
4. To continue recording, clicked and speak into the microphone again.
5. When finished, clicked to stop recording.
6. On the File menu, clicked Save As. Typed a new name for the file, selected the location to save the file, and Clicked the Save button.

4. Adding Effects to a sound file

The effect tools are located in Sound Recorder’s Effects menu.

The effects in Sound Recorder are:

<table>
<thead>
<tr>
<th>Effect Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increase Volume (by 25%)</td>
</tr>
<tr>
<td>Decrease Volume</td>
</tr>
<tr>
<td>Increase Speed (by 100%)</td>
</tr>
<tr>
<td>Decrease Speed</td>
</tr>
<tr>
<td>Add Echo</td>
</tr>
<tr>
<td>Reverse</td>
</tr>
</tbody>
</table>
**Increase Volume**

This increases the volume by 25%. (However, investigator can select this option twice for a 50% increase, three times for a 75% increase, and so on.)

**Decrease Volume**

This decreases the volume by 25%.

**Increase Speed**

This doubles the rate of a sound’s playback.

**Decrease Speed**

This slows the rate of a sound’s playback by 50%.

**Add Echo**

This adds an audio reverb.

**Reverse**

This reverses the sound so it can be played backward.

**Adding sound to animations**

The investigator has added sound to MMPs by using following steps:

1. In Slide View, selected the animated object that investigator want to add the sound effect to by clicking it.

2. Clicked the Slide Show menu, and then clicked Custom Animation.

3. Under Entry animation and sound, selected a sound effect from the drop-down list.
4. To preview the sound effect, clicked the Preview Button.

5. Clicked OK to add the sound to the animation. The sound was added to the animated object.

**Adding sound to transitions**

The investigator has added the sound files in the Presentation using following steps:

1. In slide Sorter View, clicked the slide with the transition the investigator were adding sound to.

2. Clicked the Slide Show menu, and then clicked Slide Transition. The Slide Transition dialog box appeared.

3. Selected a sound effect from the Sound drop-down list, then clicked Apply. The sound was added to the transition.

To continue playing until the next sound in the presentation, clicked the check box next to ‘Loop until next sound’.

**Adding a video clip**

The investigator has also added video clips to the presentation. Following are the steps used to add video clip in the presentation.

1. Clicked the Insert menu, point to Movies and Sounds, and then clicked Movie from File. The Insert Movie dialog box appeared.
2. In the Look in box, located the drive and folder where the investigator has saved the video clip.
3. Selected the video clip file from the file list, and then clicked OK. A video screen icon is added to the slide.

This video clip will run on this miniature screen.

4.6.2.5 Story Boarding

The researcher had collected the information, organized it sequentially. Now it was further enriched with various multimedia elements to make it more effective. At this stage the researcher decided about the placing of various elements in various steps or parts of MMP. It was more about the arrangement of the content for the presentation purpose. The researcher decided about the background music input, fading in and fading out of the text and images on the slides of MMLs. A smooth transition was also worked out at this stage.
### Table 4.14
Learning Objectives
Topic: Understanding Our Environment

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Define environment</td>
</tr>
<tr>
<td>2.</td>
<td>Understand the different kinds of environment.</td>
</tr>
<tr>
<td>3.</td>
<td>Describe the example of types of environment.</td>
</tr>
<tr>
<td>4.</td>
<td>List out the factors affecting the environment.</td>
</tr>
<tr>
<td>5.</td>
<td>Explain the difference between Abiotic and biotic environment.</td>
</tr>
<tr>
<td>6.</td>
<td>Define producers</td>
</tr>
<tr>
<td>7.</td>
<td>List the examples of producers</td>
</tr>
<tr>
<td>8.</td>
<td>Define consumers</td>
</tr>
<tr>
<td>9.</td>
<td>Describe the examples of producers</td>
</tr>
<tr>
<td>10.</td>
<td>Define and give an example of decomposers</td>
</tr>
<tr>
<td>11.</td>
<td>List out the various environmental problems</td>
</tr>
</tbody>
</table>

![Understanding Our Environment Diagram](image-url)

Fig. 4.11 Story Board of Understanding Our Environment

Table 4.15
Learning Objectives
Topic: Living and Non-living things

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Define living things</td>
</tr>
<tr>
<td>2.</td>
<td>Understand the features of living things</td>
</tr>
<tr>
<td>3.</td>
<td>List out the examples of living things</td>
</tr>
<tr>
<td>4.</td>
<td>Define Non-living things</td>
</tr>
<tr>
<td>5.</td>
<td>Explain the features of Non-living things</td>
</tr>
<tr>
<td>6.</td>
<td>List out the examples of Non-living things</td>
</tr>
<tr>
<td>7.</td>
<td>Understand the difference between living things and non-living things.</td>
</tr>
</tbody>
</table>

Fig. 4.12 Story Board of Living and Non-living things

Table 4.16
Learning Objectives
Topic: Water

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Define Water</td>
</tr>
<tr>
<td>2.</td>
<td>List out the sources of water</td>
</tr>
<tr>
<td>3.</td>
<td>Understand the uses of water</td>
</tr>
<tr>
<td>4.</td>
<td>Describe the factors that makes the water polluted</td>
</tr>
<tr>
<td>5.</td>
<td>List out the ways to preserve the water</td>
</tr>
</tbody>
</table>

Fig. 4.13 Story Board of Water
Table 4.17
Learning Objectives
Topic: Natural Resources

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Define Natural Resources</td>
</tr>
<tr>
<td>2.</td>
<td>Understand the various kinds of natural resources</td>
</tr>
<tr>
<td>3.</td>
<td>Describe the uses of natural resources</td>
</tr>
<tr>
<td>4.</td>
<td>List out the ways to protect the natural resources</td>
</tr>
<tr>
<td>5.</td>
<td>Recall the ways to stop misuse of natural resources</td>
</tr>
</tbody>
</table>

NATURAL RESOURCES

Fig. 4.14 Story Board of Natural Resources

Table 4.18
Learning Objectives

137
<table>
<thead>
<tr>
<th>S.No.</th>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Define Pollution</td>
</tr>
<tr>
<td>2.</td>
<td>Understand the different types of pollution</td>
</tr>
<tr>
<td>3.</td>
<td>Define air pollution</td>
</tr>
<tr>
<td>4.</td>
<td>List out the causes of air pollution</td>
</tr>
<tr>
<td>5.</td>
<td>Understand the effects of air pollution</td>
</tr>
<tr>
<td>6.</td>
<td>Explain the meaning and causes of water pollution</td>
</tr>
<tr>
<td>7.</td>
<td>Describe the effects of water pollution</td>
</tr>
<tr>
<td>8.</td>
<td>Define and understand the meaning and causes of soil pollution</td>
</tr>
<tr>
<td>9.</td>
<td>List out the effects of soil pollution</td>
</tr>
<tr>
<td>10.</td>
<td>Define Noise pollution</td>
</tr>
<tr>
<td>11.</td>
<td>Understand the causes and effects of noise pollution</td>
</tr>
<tr>
<td>12.</td>
<td>Discuss the ways to control the different types of pollution</td>
</tr>
</tbody>
</table>

**Fig. 4.15 Story Board of Pollution**
4.6.2.6 DATA DELIVERY

The MMPs were developed by the researcher and written on the DVDs and pen drives and were presented by the researcher to the teachers. These MMPs were also shown to Experimental Group of Elementary students.

Try-Out of the MMPs

After development, the Multimedia Package was tried out on a group of 50 elementary students of B.Ed. to obtain their response regarding effectiveness of the lessons.

Validation of MMPs

Validation (or testing) is a painstaking procedure but an essential part of the total quality assurance process. It is the study of the effectiveness of design prototypes, acknowledging any weaknesses encountered. The purpose of validation was to check to see if the program could meet its specified objectives. Realizing the objectives of the validation process required clear testing procedures to be devised. Responses of teachers to the MMPs and scores on the post-test indicated that they were instructionally sound. Changes were made when added with respect to sequence, content, presentation and clarity in language. MMPs were again reviewed and thus the final draft of MMPs was accepted and presented to the experimental group in the study.

4.7 SETTING UP MULTIMEDIA STUDIO

Before embarking on the journey of developing MMP's the instructor thought of the approach to be adopted and laid out a plan. For setting up a Multimedia Studio it was necessary for the researcher to have an understanding of the following -

1. Knowledge and understanding of various medias - software and hardware
2. Listing and understanding of various mediums.

4.7.1 HARDWARE AND SOFTWARE REQUIREMENTS

The researcher began with setting up and tuning up Multimedia Hardware in such a manner so that a well equipped multimedia studio could be set up. The
researcher studied and found that there were two distinct kinds of multimedia hardware available in the market:
1. Those with multimedia enabled motherboards - requiring little or no additional multimedia peripherals.
2. Those build with additional multimedia peripherals.
So the researcher could choose to buy a motherboard with audio input and output capabilities and thus save some cost on buying an external sound card. Or even could choose to buy a basic motherboard without multimedia capabilities and later on, add favorite sound card to it. The computer with Motherboard integrated multimedia was selected with a dedicated sound card with advanced capabilities to create next generation audio effects for MMPs.

AGP I Graphics accelerator cards were used as an interface between the computer and the monitor. While AGP cards merely handled the colour display and resolutions, graphics accelerators helped in sophisticated graphics acceleration. So AGP cards helped in getting better visuals and performances in MMPs.

The sound cards or the audio cards managed almost all possible kinds of audio including digital audio and mp3 etc. The researcher also used a pair of speakers or headphones for audio recordings. And of course, two good ears to actually hear the sounds as they come out of a sound card.

The CD Controller Cards were used to handle CD-ROM/CD-R Drives Video Capture Boards were used by the researcher to capture video contents from VCRs and Handy cams into the computer, in digital video format.

Figure 4.16 Multimedia add-on cards (Hardware setup for MMPs)
VGA to PAL I NTSC Converter Card was used to convert PC to TV.

**Multimedia software**

The term multimedia software is very generic and conceptual in nature. Theoretically, any type of software performing multimedia function or other can be termed as multimedia software. It encompasses a wide variety of tools, applications, packages, device drivers and utilities - all related to multimedia, in one way or the other.

![Multimedia Software Tools Diagram](image)

**Figure 4.17 Multimedia Software Tools**

Multimedia Software Tools - The following multimedia software were required for MMPs development -

Device Driver Software- meant for installing and configuring multimedia peripherals.

Media Players- meant for handling multimedia file formats.

Media Conversion Tools- meant for encoding / decoding multimedia contents and for converting one file format to another.

Media Editing Tools- meant for creating/ editing multimedia data.

Multimedia Authoring Tools-meant for combining different kinds of media formats and deliver them as multimedia contents.

While developing MMPs Multimedia Applications were created with the help of above mentioned Multimedia Software Tools and Packages.
External multimedia equipments used by the researcher for developing Multimedia Learning Packages

Apart from all those add-on cards that listed in the above section, some external multimedia equipment was used to carry out the tasks. Some of them were:

1. Scanner
2. Digital Camera
3. Colour laser Printer
4. Microphone
5. Multimedia Speaker
6. Digital Handy cam/ Camcorder

Similar to multimedia peripherals, not all of the above listed equipments were required for all the MMPs. It all depended upon the nature of Multimedia Package and activities involved.

How the right multimedia peripherals and equipments were chosen—

Given the myriad of brands and products available in the multimedia peripherals category, it was but a complex exercise to choose the best products among the lot and to identify those that provided professional services and offer good value for money.

142
A good starting point, before buying any piece of multimedia hardware, the researcher checked up IT magazines and websites and caught hold of review/comparisons about the product. The researcher studied some data in the periodicals that provided monthly research results and offered information on multimedia hardware and the best of the breeds available in all categories.

4.7.2 MULTIMEDIA FORMATS AND THEIR FUNCTIONALITY

The selection of the most common multimedia formats required a great care because when the researcher selected a format, also needed to time it judicially only then it could make the entire presentation could be made effective. There was no overlapping of any particular element since it could cause overdosing. Animation makes a presentation effective and moving images have the multiple uses, but a screen should not include permanently moving animation so as not to distract the user from interpretative text. The various formats of multimedia were used by researcher independently or in combination with one another in the right proportions. The choice of the format largely depended upon the nature and objectives of the concept and the availability of resources, time budget, 2-D and 3-D animation facilities for the multimedia programmes. Furthermore, it may be noted that though Multimedia Package can be a powerful learning and teaching tool because it engages multiple sense, but its success or failure largely depends on the teacher using it. Multimedia package creates a better learning environment and the students actively participate in the class. So Multimedia Package can prove an effective tool in the hands of teachers if, it is rightly used in the class.

4.8 OVERVIEW

It was envisaged that the use of three-fold self developed tools namely Achievement Test, Opinionnaire and Multimedia Package would provide enough data to examine the effectiveness of multimedia in its minutest details and help suggest the measures of impact on the stipulated variables outlined for the study. All the tools whole-heartedly endorsed the effectiveness of MMPs. The data thus collected was subjected to mean score analysis and ‘t’ value was computed to arrive at significant findings of the study.